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1  Introduction 

1.1 Integris Exam Scheduler Module 

The Exam Scheduler module integrates information entered in the Administration and Timetabling 
modules of Integris to assist school to produce exam timetables for exam supervisors and 
students.  
 
You may choose to manipulate information manually, use an automatically generated system 
solution or use a combination of both to obtain a solution. If the automatic option is selected, the 
system will produce the best possible timetable given the constraints entered. If the exam timetable 
does not fit the needs of the school, it may be manipulated manually or the constraints relaxed and 
the exam scheduler run again. 
 

1.2 Key Benefits 

Integris Exam Scheduler Module contributes to school effectiveness in the following ways: 
 

 It helps teachers and managers to carry out their responsibilities 

 It improves the use of resources available for exam supervision as it takes into account 
teachers and rooms freed up by the exams scheduled and also allows the use of relief and 
external staff for exam supervision 

 It identifies classes affected by the use of rooms for examinations and allows the allocation of 
the affected classes to other available rooms 

 It avoids the need for time-consuming manual statistical calculations as a series of reports 
significantly automates the process for school-based staff. 

 

1.3 Key Features 

Integris Exam Scheduler Module includes the following key features: 
 

 Is simple to set up and run 

 Supports all aspects of exam scheduling for students, supervisors, sessions, rooms within one 
simple, easy-to-use interface 

 Includes a wide range of standard reports  

 Can be configured for and by the people using it, including the descriptions of any codes used 

 Has seamless links with the other Integris Management Solutions products, avoiding the need 
for any re-entering of school, staff or student data. 

 

1.4 Glossary 

The terminology used in this Manual is described in the following glossary. 
 

 DoE   - Department of Education (WA) 

 Exam Schedule  – describes the overall examination timetable and associated data  

 Exam Session  – a specific line, row or band of the exam grid 

 Exam Timetable  – describes the specific grid view shown in Examination Timetable 
Management 

 SIS   – Student Information System (Integris). 
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1.5 How to Use this Manual 

This manual describes the features and facilities available in Integris Exam Scheduler module, a 
component of the Integris suite of software. 
 
You should refer to this guide if you are responsible for setting up examination timetables and 
allocating exam supervisors and rooms.  It describes how to enter and manage information and 
print reports.  The sections are listed below. 
 
Section 1: Introduction to Integris  This section describes the product and its 

benefits.  It also describes the contents of this 
guide. 
 

Section 2: Getting Started This section explains the basic functions that 
you need to become familiar as a new user of 
Administration Manager and the Exam 
Scheduler Module.  It also covers the tasks that 
need to be carried out before you can start to 
use the rest of the product effectively.  
 

Section 3: Adding and Removing Modules  This section describes how to add new modules 
to the suite of Integris modules, and how to 
remove a module. 
 

Section 4: Maintaining Parameters This section details the parameter functions that 
impact on the Exam Scheduler module. 
 

Section 5: Maintaining School Details This section details how to set up a new 
academic year in the School Diary, recording 
events and closed days in the calendar, and 
how to print term and year views of the school 
diary. 
 

Section 6: Examination Schedule Setup This section describes how to set up details of 
your Exam Timetable Schedules 
 

Section 7: Examination Timetable Management This section defines how to manipulate an 
Exam Timetable grid either manually or 
automatically by using the generation process. It 
also describes how to allocate exam 
supervisors and rooms to an exam timetable. 
 

Section 8: Examination Schedule Reports  This section describes how to produce the 
various standard reports that are supplied with 
the Exam Scheduler module. 

Section 9: Index  
 

Section 10: Support This section provides information on accessing 
support for using the Exam Scheduler module. 
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2 Getting Started 
The facilities available in the Exam Scheduler module are covered in this manual.  Also included 
are relevant features of the Administration Manager module which are necessary for using the 
Exam Scheduler. 
 

2.1 Log On 

To log onto the system following the successful installation of the software, either: 
 

 Double-click on the Integris icon on your desktop  
OR 

 Click on the Windows Start button 

 Select Programs  

 Select RM Management Solutions 

 Double-click on Integris 
 
If you are using Integris for the first time after its initial installation you will be provided with a user 
name and password to log onto the software.  Should you experience any difficulties please 
contact the Customer Service Centre.  (See Section 0 for Support information.) 
 

 
 

 Enter your User Name and Password  

 Click Login or press <Enter> on the keyboard 
 
If you are using a new data file, the system displays the School Details window.  The main details 
of the school must be completed before any processing can take place.  See the Administration 
Manager manual for further details. 

Note: When you log on to the system, a validation routine is automatically run to ensure 
that the data file you are using is synchronised with its associated partner file.  If 
there is a discrepancy, a warning message is displayed.  If this occurs, contact your 
Customer Service Centre for guidance. 
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2.2 Exit Integris 

 Click on the File menu in the top left hand corner of the window 
 

 
 

 Click Exit  
 

  
 

 Click Yes 
 

2.3 Change Password 

File > Password 

You should change your password at regular intervals for security purposes.  To change your 
password: 
 

 Click on File menu in the top left hand corner of the window 

  
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  

 Click on Password  
 

 
 

 Enter your Current Password 

 <Tab> 

  Enter your New Password  

 <Tab> 

  Enter your new password again 

 Click OK 

Note: You are warned if the text you enter in the Verification field is not the same as the 
New Password you entered.  If you see the warning message, click OK and re-enter 
the new password in the New Password and Verification boxes. 
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2.4 Lock Terminal 

File > Lock Terminal 

If you need to leave your work station for a short period of time but do not want to log out of 
Integris, you can temporarily lock the software to prevent any unauthorised access.  
 
Either: 

 Click on the File menu at the top of the window and select Lock Terminal  
 

 
 
Or 
 

 Press <Ctrl> + <L> 
 
Whichever method you choose, the system displays the Lock Details window. 
 

 
 

To unlock the terminal: 

 Click on Unlock 
 

 
 

 Enter your password. 

 Click OK 
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2.5 Integris Help  

Help > Help Contents & Index 

Integris Help is located at the top of the screen.  
 

 
 

 Click on Help  
 

 
 

 Select Help Contents and Index   
 

 
 

 Double click on the required file or select the required file and click Help 
 
Once the help file has opened: 

 use Search to locate the required information 
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2.6 General Sidebar 

The core features in Integris are grouped on the General sidebar. 
 

 
 

 School Details – used to enter and maintain information relating to the 
school, as well as providing access to the school diary 
 

 Student Details – used to enter and maintain information relating to the 
students associated with the school 
 

 Staff Details – used to enter and maintain information relating to the staff 
associated with the school 
 

 Groups – used to enter details of staff and student groups 
 
 

 Parameters – used to set up and maintain a range of fields, codes and 
descriptions to be used throughout Integris 
 

 Control – used to set up options for Integris administration and to import 
information from other systems 
 
 

 
 
 
  



 
IntegrisExamSchedulerManual.docx 6-Dec-13  

Page 2-8 

© 2013 Civica Education Pty Ltd 

 

 

2.6.1 Add Module 

General > Control  

Before the Exam Scheduler module can be accessed by users in your school, you must add it to 
the system. 
 

 
 

 Double click on Add Module 
 

 

Note: all available modules are located in K:\Keys\Integris\Bin.   

 Double click on EXAMSCHED.lbr 
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 Click OK 
 
The Exam Scheduler icon will now be available from the Timetabling sidebar 
 
 

2.7 Timetabling Sidebar 

The timetabling features of Integris are grouped on the Timetabling sidebar. The Exam Scheduler 
module is available from the Timetabling sidebar. 
 

 

 Student Course - displays for each student a list of preferences, the 
student’s timetable and the relevant grid for the student with member teaching sets 
highlighted 

  

 Timetable - displays the current whole school timetable that may be filtered 
by year, cycle, schedule, grid or department 

  

 Grid Modelling - allows you to manually manipulate the grid or to define 
constraints and use the auto-scheduler to model the grid  

  

 Preferences – allows you to entry students’ subject preferences individually 
or in bulk 

  

 Reports - allows you to access a wide variety of timetable reports  

  

 Timetable Setup - used to define all aspects of the timetable prior to creation 
of a new timetable 

  

 Exam Scheduler – even though this is represented as an icon on the 
Timetabling sidebar, this is a complete module whose functionality is described in this 
manual 
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3 Preliminary Setup 
There are specific setup features that will maximise the performance of the Exam Scheduler 
module.  Some features are critical in order to enable certain functionality, whilst other features will 
enhance module usage. 

Note: The Exam Scheduler module is dependent on there being an existing timetable for 
the period for which the exams are to be scheduled.  There are essential parameters which 
need to be defined for the Timetabling module which, in turn, inform Exam Scheduler. 

 

3.1 Parameters related to Exam Scheduler  

General > Parameters 

Room and Subject parameters relate to Exam Scheduler. 
 

3.1.1 Rooms 

General > Parameters > Rooms 

 
 
Each Room parameter has an Exam Capacity field.  This value is used when allocating rooms for 
an exam session.  (Refer to Section 4.2.5 for further detail on allocating rooms.) 
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Edit Exam Capacity 

 Select the room to be edited 

 If the parameter is locked, click  and Yes 

 Click Edit  

 Enter a value in Exam Capacity 

  

 

Note: an Exam Capacity greater than 0 makes the room available to Exam Scheduler 

 Check Locked if required 

 Click OK to save  
 

3.1.2 Subjects 

General > Parameters > Subjects 

 
 
In the Subject parameters, there are three fields relevant to Exam Scheduler: 

 Examinable indicates whether or not a subject is to be examined 

 Exam Duration stores a subject’s default exam duration (this is free text field) 
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 Suspended for Exam Period indicates whether or not classes for this subject are to be 
suspended for the duration of the exam period.   

Edit Subject 

 Use Search to locate the subject to be edited 
 

 
 

 <Enter> 

 Click Edit  

 Enter the required details 
 

 
 

 Click OK 
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3.2 Staff Details 

General > Staff Details 

Staff members can be classified as one of three types: Current, Former or External. Enter external 
exam supervisors as external staff and check Active External Exam Supervisor.  
 

  
 

3.2.1 Add an External Exam Supervisor 

General > Staff Details 

 Select the External roll  
 

 
 

 Click Add  

 Enter the staff member’s details 

Note: only Title, First Name and Surname are mandatory.  

 Check Active External Exam Supervisor  
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 Click OK to save 
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4 Examination Schedule Setup 

4.1 Examination Schedule Setup Overview 

Timetabling > Exam Scheduler > Examination Schedule Setup 

The purpose of Examination Schedule Setup is to setup, view and manage Exam Schedule 
records. Every exam schedule is created, modified and deleted through this window.  The setup 
window allows the user to create exam schedule records and set up associated details for that 
exam schedule.  For each exam schedule record, the user can set up the name of the exam 
schedule, on which date the exams start, for how many days the exams are run for and the days 
which are affected.  The timetabling year, semester and timetabling grid(s) for which the exams are 
scheduled are also specified here. 
 (Timetabling > Exam Scheduler > Examination Schedule Setup) 
 

 
 
 
  

Window toolbar icons 

Five main tabs allow for Exam 
Schedule Setup (default tab is 
Definition) 

OK and Cancel buttons 

Report time format 
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4.1.1 View Mode 

View Mode is the default mode for the Examination Schedule Setup window.  Exam Schedules for 
the current year will be in the browse list in this mode. Exam Schedules may be selected browsing 
through or searching for a selected one which includes any from previous years.  The window 
remains in View Mode until the Add or Edit icon is clicked. 
 

4.1.2 Add Mode 

Add mode enables you to add a new Exam Schedule by either entering the schedule details from 
scratch or cloning an existing Exam Schedule. 
 

4.1.3 Edit Mode 

In Edit Mode you can make changes to existing Exam Schedules.  You will be warned about 
related data changes if key changes are made. 
 

4.1.4 Toolbar Icons 

The following Icons are available in the Examination Schedule Setup window in the top toolbar.  
 

Toolbar Element Icon Hover Text View Mode 
Add/Edit 

Mode 

No Browse set indicator   Visible – disabled Disabled 

Browse set indicator  Clear Browse Set 
Only enabled in 
Browse set 

Disabled  

Previous Exam 
Schedule record  Previous Record Enabled Disabled 

Next Exam Schedule 
record  

Next Record Enabled Disabled 

Find Exam Schedule 
record button  Find Record Enabled Disabled 

Create Exam Schedule 
button  

Create New Exam Schedule 
Record 

Enabled Disabled 

Edit Exam Schedule 
button  

Edit Exam Schedule Record Enabled Disabled 

Delete Exam Schedule 
button  Delete Exam Schedule Record Enabled Disabled 

Print button 
 

Print Exam Schedule Record Enabled Disabled 

Save button  Save Changes Disabled Enabled 
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4.1.5 Browse Existing Exam Schedules 

The Examination Schedule Setup > Definition window opens in View mode.  By default only Exam 
Schedules for the current year will be in the browse list.  The exams will be sorted from newest to 
oldest creation date. 

 Click on  to browse to the next Exam Schedule record. 

 Click on  to browse to the previous record. 
 

4.1.6 Search for an Existing Exam Schedule Record 

 Click on Find Record  
 

 
 
To populate the Exam Schedule Search results list you can either: 
 

 Enter a title in Schedule Title field 

 Select All in TT Year 

 Click on Find or press Enter on the keyboard. 
 
Or 
 

 Leave the Schedule Title blank 

 Select All in TT Year 

 Click on Find or press Enter on the keyboard 
 
Or 
 

 Enter a Schedule Title 

 Select a TT Year 

 Click on Find or press Enter on the keyboard 
 

 Once  Exam Schedules are successfully listed in the Exam Schedule Search Results window 
pane: 
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 Highlight one or more Exam Schedules as required   
 
To select multiple records you can: 

 Hold the <Ctrl> key down and left mouse click on the required records 

 Hold the <Shift> key down and use the left mouse click or the keyboard arrow keys 

 Hold down the left mouse click and drag the mouse down the list of rows 

 Press <Ctrl + A> on the keyboard to select all records 
 

 Click Select   
 
If multiple schedules are selected, these now becomes the browse set in the Examination 
Schedule Setup window. The selected Exam Schedule title displays in the Examination Schedule 

Setup window header and the browse set indicator  button will be enabled. While the browse 

set is enabled, utilising the previous record  and next record  buttons will function only across 
the selected Exam Schedules. 
 
To will clear the browse set: 

 Click on the active browse set indicator   
 

The browse set indicator  button is then disabled. 
 

4.2 Add/Create a New Exam Schedule 

4.2.1 Definition 

Timetabling > Exam Scheduler > Examination Schedule Setup 

 Click on Create New Exam Schedule Record   

 Enter an Examination Schedule Title 
 

 
 

 Enter an Exam Start Date  

 Enter a whole number in the No. of Days for Exams  

 Select the required timetable year from the TT Year drop-down menu   

 Select the associated Timetabling Schedule and Cycle 
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 Check Days to be used for Exams  

 Enter a Maximum Group Size  

 Highlight one or more grids to be included in the Exam Schedule 

 Set the Report time format  
 

 
 

 Save  or click OK 

Note: Save  saves what you have done but stays in Edit mode.  OK saves what you have 
done but returns to View mode.   
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4.2.2 Schedule 

Timetabling > Exam Scheduler > Examination Schedule Setup > Schedule 

The purpose of this tab is to set up Exam Session start times for all the exam days determined by 
the days and exam start date specified in the Definition tab. 
 

 
 

 Locate the required Exam Schedule by using Browse or Search 

 Click on Edit Exam Schedule Record  

 Click in the first session 

 Enter the start time for the session in the format hh:mm ranging from 0:00 to 23:59 

 <Tab> to move to the next cell 

 Enter the start time for this session 
 

 
 
You can continue to enter session times in this way or you can copy the first day’s session time to 
the rest of the days listed 
 

 Put your cursor is in the session that you want to copy 

 Click on Fill Structure Down  

  
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 Click Yes  
 

 
 

 Repeat for other sessions as required 

 Save  or click OK 

Note: Save  saves what you have done but stays in Edit mode.  OK saves what you have 
done but returns to View mode.   
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4.2.3 Add Exam Sessions 

 Locate the required Exam Schedule by using Browse or Search 

 Click on Edit Exam Schedule Record  
 
The number of columns for exam sessions defaults to two (Session 1 and Session 2) but additional 
columns may be added. 
 

 
 

 Click on Add a Column    
 

 
 

 Enter the session times 



 
IntegrisExamSchedulerManual.docx 6-Dec-13  

Page 4-10 

© 2013 Civica Education Pty Ltd 

 

 Save  or click OK 

Note: Save  saves what you have done but stays in Edit mode.  OK saves what you have 
done but returns to View mode.   

This may be repeated as many times required. 

Note: any Session columns, from Session 3 and beyond, which do not have session times 
entered will be removed when you click Save or OK. 

 

4.2.4 Add Subjects 

Timetabling > Exam Scheduler > Examination Schedule Setup > Subjects 

On this tab you can identify and manage the subjects to be examined. 
 

 Locate the required Exam Schedule by using Browse or Search 

 Click on Edit Exam Schedule Record  

 Click on the Subjects tab 
 

 
 
All of the subjects listed come from the grid(s) selected on Definition tab, provided that at least one 
student has a satisfied preference for that subject.  The values for each subject come from 
General > Parameters > Subjects but some fields, Examinable, Suspended, Duration and No. 
Exams, may be edited here for a specific exam schedule.  Multiple subjects can be selected for 
editing 
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The following icons are available under Subjects tab: 
 

Icon Hover Text View Mode Add/Edit Mode 

 
Edit Subject Details Disabled Enabled 

 
Edit Multiple Exams Disabled Enabled 

 
Toggle Examinable Disabled Enabled 

 
Toggle Suspended Disabled  Enabled  

 
Keep Together Disabled Enabled 

 Teaching Sets Disabled 
Enabled when an examinable 
subject is selected 

 

To Edit Examinable: 

 Select the subject(s) to be edited 

 Click Toggle Examinable  

 Save  or click OK 

Note: Save  saves what you have done but stays in Edit mode.  OK saves what you have 
done but returns to View mode.   

To Edit Suspended: 

 Select the subjects(s) to be edited 

 Click Toggle Suspended  

 Save  or click OK 
 

To Edit Duration and No. Exams: 

 Select the subjects(s) to be edited 

 Click Edit Subject Details  
 

 
 

 Enter the new required values and click OK 

 Save  or click OK 
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Note:  If a new value is entered onto only one of these fields, the other will remain 
unchanged. 

Edit Multiple Exams  

 If a subject has multiple exams, each of those exam names and durations can be viewed and 
edited in the Edit Multiple Exams window. The subject name will always be linked to the first 
multiple exam record. 

 

 Highlight the subject(s) to be edited and click on the Edit Multiple Exams  
 

 
 

 Make the required changes and click OK 

Note: Only Duration and Exam Name may be edited. 

 

 

Subjects display in red 
to indicate changes 
have been made. 

This subject has only one 
exam therefore is 
disabled for editing.  
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Note: The Duration displayed in this window is that of the first exam. 

 Save  or click OK 

Note: Save  saves what you have done but stays in Edit mode.  OK saves what you have 
done but returns to View mode.   

  

Keep Together Constraint  

Use Keep Together to schedule exams for certain subjects at the same time.   
 

 Click on Keep Together  
 

 
 
The following icons are available on the Constraint Definition window. 
 

 - Create New Constraint 

 - Edit Constraint 

 - Delete Constraint 

 - Remove Selected Subject(s) 

 - Add Selected Subject(s) 

 
  



 
IntegrisExamSchedulerManual.docx 6-Dec-13  

Page 4-14 

© 2013 Civica Education Pty Ltd 

 

 

To Add a Constraint 

 Click on Create New Constraint  
 

 
 

 Enter a Constraint Name and click OK  

 From the Available Subjects list highlight the subject(s) that will be part of the constraint 

 Click on Add Selected Subject(s)  to move selected subjects from the Available Subjects 
list to the Constraint Subjects list 

Note: click on Remove Selected Subject(s)  to move selected subjects from the 
Constraint Subject list to the Available Subjects list 

 Click  to close the Constraint Definition window 
 

 Save  or click OK 

Note: Save  saves what you have done but stays in Edit mode.  OK saves what you have 
done but returns to View mode.   

 

Exclude Teaching Sets from an Exam Schedule 

 There may be instances when only certain teaching sets for a subject are included in an exam.  
Examinable teaching sets within a subject can be identified using Edit Available Teaching 
Sets.   

 

 Highlight one or more examinable subjects 

 Click on Teaching Sets  
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 Uncheck the teaching sets that are not to be included in the exam and click OK 

 Save  or click OK 

Note: Save  saves what you have done but stays in Edit mode.  OK saves what you have 
done but returns to View mode.   

 

4.2.5 Add Rooms 

Timetabling > Exam Scheduler > Examination Schedule Setup > Rooms 

Go to the Rooms tab is to set up and manage the available rooms to be used for the exams. You 
are also able to see how many seats in total are available for the exams. 
 

 Locate the required Exam Schedule by using Browse or Search 

 Click on Edit Exam Schedule Record  

 Click on the Rooms tab 
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The Available Rooms listed are derived from General > Parameters > Rooms.  If a room has a 
capacity of zero in Parameters, it does not appear in the Available Rooms list. 

Note: Rooms given an Exam Capacity after the Exam Schedule has been created do not 
appear in the Required Rooms window pane. 

 Highlight the required rooms in the Available Rooms pane  

 Click on Add Room(s)…  
 

 
 

 Maximum Capacity is displayed at the bottom of the window. 
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Note: click on Remove Room(s) …  to remove any rooms from the Required Rooms list. 

 Save  or click OK 

Note: Save  saves what you have done but stays in Edit mode.  OK saves what you have 
done but returns to View mode.   

 

4.2.6 Supervisor 

Timetabling > Exam Scheduler > Examination Schedule Setup > Supervisor 

In Supervisor you can specify who will be responsible for supervising exams.  Internal Supervisors 
are any current school-based teaching staff.  External Supervisors are not school-based teachers 
but they are used by the school to supervise exams. 
 

 Locate the required Exam Schedule by using Browse or Search 

 Click on Edit Exam Schedule Record  

 Select the Supervisor tab 
 

 

Note:  Internal is checked by default and can only be unchecked if External has been 
checked. . 

 Uncheck Internal to make the current teaching staff unavailable for exam supervision  

 Check External box to make the external supervisors list available for exam supervision  
 
If you wish to update the records of external exam supervisors:  

 Click on Update External   
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 Click Add  or Edit  and enter details as required 

 Click OK to save 

 Click  to return to the Examination Schedule setup window 
 
If you wish to remove some of your teachers from the list of available internal supervisors: 

 Click Select Internal Supervisors 
 

 
 
By default, all current staff members, except those with a Staff Type of Non-Teaching, are flagged 
as available for exam supervision.  To mark any of them as unavailable: 

 Highlight their names and click Toggle Active Status  
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 Click OK 

 Save  or click OK 

Note: Save  saves what you have done but stays in Edit mode.  OK saves what you have 
done but returns to View mode.   

 

4.2.7 Print an Exam Schedule Definition Report 

Timetabling > Exam Scheduler > Examination Schedule Setup 

 Locate the required Exam Schedule by using Browse or Search 

 Click on Print Examination Setup Definition Report  
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 Select the required report destination and click OK 
 

Sample Examination Setup Definition Report 
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4.2.8 Print Exam Subject Requirements Report 

Timetabling > Examination Schedule Setup >Subjects  

You can print can print this report when the window is in View mode. This report lists all the 
examinable subjects, by subject code and subject name, the number of students taking each 
exam, the exam duration and subject notes that have been entered in Exam Timetable 
Management. (See Section 5.3.3.) 
 

 Locate the required Exam Schedule by using Browse or Search 

 Select the Subjects tab 
 

 
 

 Click on Exam Subjects Requirements Report  
 

 
 

 Select the required report destination and click OK 
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Sample Exam Subjects Requirements Report  
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4.3 Clone a Previous Exam Schedule 

Timetabling > Exam Scheduler > Examination Schedule Setup 

 Click on Create New Exam Schedule Record  
 

 
 

 Click on  
 

 
 

 Click on the drop-down arrow and select the Exam Schedule you wish to clone 

 Click OK 

 Edit the Exam Schedule Title, Exam Start Date and any other fields as required 
 



 
IntegrisExamSchedulerManual.docx 6-Dec-13  

Page 4-25 

© 2013 Civica Education Pty Ltd 

 

 
 

 Save  or click OK 

Note: Save  saves what you have done but stays in Edit mode.  OK saves what you have 
done but returns to View mode.   

 
 

 Click Yes 

 On the Session tab, enter the required Session times 
 



 
IntegrisExamSchedulerManual.docx 6-Dec-13  

Page 4-26 

© 2013 Civica Education Pty Ltd 

 

 
 

 Save  or click OK 

Note: Save  saves what you have done but stays in Edit mode.  OK saves what you have 
done but returns to View mode.   

 Edit Subjects, Rooms and Supervisor as required 

 Save  or click OK 
 
 

4.4 Delete an Exam Schedule 

Timetabling > Exam Scheduler > Examination Schedule Setup 

 Locate the required Exam Schedule you wish to delete using Browse or Search 

 Click on Delete Exam Schedule Record  
 

  
 

 Click Yes  
 
 



 
 

  

Exam Scheduler Manual 
 

Exam Timetable Management 

5 

 

                                    Exam Scheduler 
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5 Exam Timetable Management 

Timetabling > Exam Scheduler > Examination Timetable Management 

 
 
The Exam Timetable Management window manages all functionality associated with generating, 
manipulating, staffing, rooming and managing the full exam timetable. 
 
Subjects on the Examination Timetable Management screen can be placed on the grid in one of 
three ways: 
 

 Manually placing the subjects on the grid and generating nothing (that is, creating a fixed grid) 

 Manually placing the subjects on the grid and automatically generating the rest of the subject 
placements around the fixed subjects 

 Automatically generating all subject placements 
 
Once subjects are placed on the grid, rooms, exam timeslots and supervisor detail are all added 
manually to the grid. 
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5.1 Exam Timetable Management Window 

Timetabling > Exam Scheduler > Examination Timetable Management 

 
 

5.1.1 View Mode 

View mode is the default mode for the Examination Timetable Management window.  In this mode 
Exam Schedules may be selected from the Previously Saved Exam Session dropdown list for 
viewing of the associated Exam Timetable Grid.  The window remains in View Mode until the Edit 
icon is clicked. 
 

5.1.2 Edit Mode 

In Edit mode the Exam Timetable Grid associated with the currently selected Exam Schedule is 
made available for editing. Editing the Grid involves the placement and allocation of Subjects, 
Rooms, and Supervisors.  This is performed manually by the user. In the case of subjects, 
automatic placement is also possible through the use of the Generate function.  The window 
remains in Edit mode until the OK or Cancel buttons are clicked. 
 
 
  



 
IntegrisExamSchedulerManual.docx 6-Dec-13  

Page 5-4 

© 2013 Civica Education Pty Ltd 

 

 

5.1.3 Examination Timetable Management Toolbar  

Timetabling > Exam Scheduler > Examination Timetable Management 

Toolbar Element Icon Hover Text View  Edit  

Default   Set Exam Schedule as default Enabled Disabled 

Scroll  
 

Display/Hide Subjects Disabled Enabled 

Print  
 

Print Exam Timetable by Day & 
Time 

Enabled Disabled 

Edit Exam Timetable  
 

Edit Exam Timetable Enabled Disabled 

Save  
 

Save Exam Timetable Disabled Enabled 

Generate   Add subjects to the Grid Disabled Enabled 

Reports   Reports Enabled Disabled 

Hide Rooms  Hide/Display Room Cells Disabled Enabled 

Add Column   Add a column Disabled Enabled 

Move Subject left 
 

Move Subject Left (Alt + L) Disabled Enabled 

Move Subject right  
 

Move Subject Right (Alt + R) Disabled Enabled 

 

5.2 Place Subjects on an Exam Grid 

You can place subjects on an exam grid manually or they can be placed automatically, subject to 
any constraints you may have entered. 
 

5.2.1 Manual Subject Placement 

Timetabling > Exam Scheduler > Examination Timetable Management 

 Select the required examination schedule from the drop down list 
 

 
 

 If required, click on the Set Exam Schedule as default  
 

 
 

 Click OK  
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 Click Edit  and Display Subjects  
 

 
 
In the left-hand pane, you will see a list of all the subjects to be examined.  
 
To place subjects on the grid: 

 Click on the required subject and drag and drop it into an empty cell on the grid in the required 
row 

 
Once a subject is placed on the grid, it will turn red in the Subject pane. 
 

 
 
If placing a subject on creates a conflict, you will be warned. 
 

 
 
To see the clash: 

 Click View Clash 
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If a subject that is part of a Keep Together Set is placed on the grid), all subjects in that set will be 
placed on the same grid band. 
 

 
 
Subjects that are manually placed on the grid are automatically marked as Fixed.  This is indicated 
by an (F) appearing in the subject cell.  This means that these subjects will not be removed or 
repositioned during Automatic Subject Placement 
 
If you wish to move or remove a subject on the grid or mark it as Non-Fixed: 

 Right click on the relevant subject and select the required option 
 

 
 
When you have completed, manually placing subjects on the grid: 

 Click Save …  
 

 
 

 Click OK 
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5.2.2 Automatic Subject Placement 

Timetabling > Exam Scheduler > Examination Timetable Management 

 Select the required examination schedule from the drop down list 
 

 
 

 If required, click on the Set Exam Schedule as default  
 

 
 

 Click OK  

 Click Edit  and Generate  
 

 
 

 Click Yes 
 
If the Maximum Group Size specified in Exam Schedule Setup is less that group size for the 
largest examinable subject or largest Keep Together Set or the total size of all the Fixed subjects in 
any session, then you will see this message: 
 

 
 

 Click Yes or No as required 
If there were not enough sessions created in Exam Schedule Setup to place all examinable 
subjects on the grid, then you will see the following message: 
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 Click OK and go to Exam Schedule Setup to add more sessions 

 
If automatic subject placement was successful, you will see your new exam grid. 
 

 
 

 Click  to save 
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 Click OK 
 

5.2.3 Conflict Check 

A conflict check is performed whenever Edit  is clicked in the Exam Timetable Management. It 
examines the students in the subjects placed on the exam timetable grid to determine whether 
there are any students who have more than one exam scheduled at the same time.  If there are, 
you will see this message. 
 

 
 

 Click Yes to see the conflict list  
 

 
 

 View, then Close 
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 Click Yes or No as required  
 
If you click Yes, you will see this message. 
 

 
 

 Click Yes or No as required  
 
If you click Yes, you will see your new exam grid. 
 

 Click  to save 
 

 
 

 Click OK 
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5.3 Grid Manipulation – 

Once subjects have been placed on the grid either manually or automatically, they can be 
manipulated to achieve a required solution. Rooms and Supervisors can also be allocated to the 
Exam sessions on the Exam Timetable. 
 

5.3.1 Move Subjects in the same Row on the Grid 

Timetabling > Exam Scheduler > Examination Timetable Management 

 Select the required examination schedule from the drop down list 
 

 
 

 If required, click on the Set Exam Schedule as default  
 

 
 

 Click OK  

 Click Edit  

 If a new column is required, click Add a column  

 Select the subject you wish to move by clicking in the cell on the grid  

 Click on  to move it to the left or  to move it to the right  
 
Once subjects are placed as you wish: 

 Click  to save 
 

 
 

 Click OK 
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5.3.2 Move Subjects to another Row in the Grid 

Timetabling > Exam Scheduler > Examination Timetable Management 

 Select the required examination schedule from the drop down list 
 

 
 

 If required, click on the Set Exam Schedule as default  
 

 
 

 Click OK  

 Click Edit  
 

 Right click on the subject cell which contains the subject to be moved 
 

 
 

 Select Move Subject 
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 Select the row you wish to move the subject to 
 
If a conflict results, you will see this message: 
 

 
 

 Make your preferred selection  
 
Once subjects are placed as you wish: 

 Click  to save 
 

 
 

 Click OK 

Note: if the subject you wanted to move is part of a Keep Together Set, all subjects in that 
set are will be moved together.   
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Note: If rooms have been allocated to a Subject prior to its successful move, the rooms are 
removed from the subject as these may create clashes, or rooming issues.  Therefore 
rooms will need to be allocated again.  Exam Supervisor information is also removed. 

 

5.3.3 Add Note 

Timetabling > Exam Scheduler > Examination Timetable Management 

 Select the required examination schedule from the drop down list 
 

 
 

 If required, click on the Set Exam Schedule as default  
 

 
 

 Click OK  

 Click Edit  
 

 Right-click in the cell which contains the subject you want to add a note to 
 

 
 

 Select Add Note 
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 Type your note and click OK will save Notes. 

Note: notes are stored universally, that is any changes made to a subject’s note are 
reflected across all Exam Schedules. 

When all required notes have been entered: 

 Click  to save 
 

 
 

 Click OK 
 

5.3.4 Move Row 

Instead of just moving a single subject from one row to another, you may wish to move all the 
subjects in a row. 

Timetabling > Exam Scheduler > Examination Timetable Management 

 Select the required examination schedule from the drop down list 
 

 
 

 If required, click on the Set Exam Schedule as default  
 

 
 

 Click OK  

 Click Edit  
 

 Right-click in the row you wish to moved 
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 Select Move Row 
 

 
 

 Select the required row and click OK 
 
Once subjects are placed as you wish: 

 Click  to save 
 

 
 

 Click OK 
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5.3.5 Allocate Rooms 

Once subjects have been placed on the exam timetable grid, rooms can be allocated to those 
exams. 

Timetabling > Exam Scheduler > Examination Timetable Management 

 Select the required examination schedule from the drop down list 
 

 
 

 If required, click on the Set Exam Schedule as default  
 

 
 

 Click OK  

 Click Edit  
 

 
 

 Right click on an empty room cell and select Allocate Room 
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Note: the Available Capacity for each room is displayed. 

 Select the required room and click OK 

If the room selected is not large enough for the exam you will see this message: 
 

 
 
If you click OK, the Required Rooms window remains open. 
 

 Make further selections until the insufficient space message is no longer displayed. 
 

 You will see the multiple rooms displayed in the exam grid. 
 

 
 

 Continue to allocate rooms 
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When all rooms have been allocated: 

 Click  to save 
 

 
 

 Click OK 
 

5.3.6 Change Rooms 

Once rooms have been allocated, they can also be changed. 

Timetabling > Exam Scheduler > Examination Timetable Management 

 Select the required examination schedule from the drop down list 
 

 
 

 If required, click on the Set Exam Schedule as default  
 

 
 

 Click OK  

 Click Edit  
 

 Right click in a room cell that contains a room 
 

 
 

 Select Change Room 
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 Select a room and click OK 

If the room selected is not large enough for the exam you will see this message: 
 

 
 
If you click OK, the Required Rooms window remains open. 
 

 Make further selections until the insufficient space message is no longer displayed. 
 

 You will see the multiple rooms displayed in the exam grid. 
 

 
 
When all rooms have been satisfactorily assigned: 

 Click  to save 
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 Click OK 
 

5.3.7 Remove Rooms 

 Select the required examination schedule from the drop down list 
 

 
 

 If required, click on the Set Exam Schedule as default  
 

 
 

 Click OK  

 Click Edit  
 

 Right click in a room cell that contains a room 
 

 
 

 Select Remove Room 

Note: any students allocated to the cleared room will no longer be allocated to a room and 
any supervisors allocated to the cleared room will also be lost. 
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5.3.8 View/Edit Students Allocated to a Room  

Timetabling > Exam Scheduler > Examination Timetable Management 

 Select the required examination schedule from the drop down list 
 

 
 

 If required, click on the Set Exam Schedule as default  
 

 
 

 Click OK  

 Click Edit  
 

 Right click in a room cell that contains a room 
 

 
 

 Select Show / Edit Allocated Students 
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This window contains a list of locked students and their allocated room for the selected subject. 
 
To view students also allocated to the selected room, but for a different subject: 

 Click on the Subject drop-down arrow and select a different subject 
 

 
 
To change a student’s allocated room:  

 Click in the Locked checkbox for a student 

Note:  
To unlock all students, click on Unlock All. 
 
Closing the Examination Room Student Allocation window will automatically re-lock any 
unlocked students. 

 Click on the Room drop-down arrow for an unlocked student 

 

 
 
The list contains all rooms allocated to the same subject that have available space. 
 

 Select an alternative room and click OK 

 



 
IntegrisExamSchedulerManual.docx 6-Dec-13  

Page 5-24 

© 2013 Civica Education Pty Ltd 

 

To print a list of students allocated to a room: 

 Click Print 

 

 
 

 Select the required Report Destination and click OK 

 

5.3.9 Allocate Substitute Room 

When a room is being used for exams, you need to be able to identify what classes are usually 
taught in that room and to re-allocate them classes to other rooms.  

Timetabling > Exam Scheduler > Examination Timetable Management 

 Select the required examination schedule from the drop down list 
 

 
 

 If required, click on the Set Exam Schedule as default  
 

 
 

 Click OK  

 Click Edit  
 

 Right click in a room cell that contains a room 
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 Select Allocate Substitute Room 
 

 
 

Replace Room for the Entire Exam Timetable 

The Entire Exam Timetable option attempts to substitute an alternative room for all occurrences of 
the chosen room. 
 

 Select Replace Room for the Entire Exam Timetable and click OK 

 
If no subjects are affected, you will see this message. 
 

 
 

 Click OK 

 
If subjects are affected however no room is available to cover for the entire exam timetable, you 
will see this message. 
 

 
 

 Click OK 

 
If subjects are affected and rooms are available, you will see this window.  
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 Select an appropriate room and click OK 

 
If any of the periods for affected subjects have already had a substitute Room allocated, you will 
see this message. 
 

 
 

 Click OK 

 

Replace Rooms for Subjects Affected 

Use this option if, no substitute room is available to cover for the entire exam period. 
 

 Select Replace Rooms for Subjects Affected and click OK 

 
If no subjects are affected, you will see this message. 
 

 
 

 Click OK 
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 Select a subject in the Subjects Affected pane.  
 
The white cells in the centre pane indicate the periods in which this subject is affected. 
 

 Select a suitable room from the Available Rooms pane and click     
 

 
 

 Select the next subject in the list 
 

 
 

 Click Yes 
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 Repeat these steps until all subjects have been allocated a room 

 Click OK 
 

Allocate Substitute Rooms to Individual Periods 

Use this option if, no substitute room is available to cover an affected subject for the entire exam 
period. 
 

 Right-click in one of the white cells in the centre grid 

 A period-specific Available Room selection window appears. 

 

 
 
You will see a list of available rooms for that period. 
 

 Select a room from the list 

 

 
 

 Repeat for the other periods 

 Click OK 
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When all substitute rooms have been allocated: 

 Click  to save 
 

 
 

 Click OK 
 

5.3.10 Time Slot Definition 

Unless you are planning to assign exam supervisors for the entire duration of an exam, you will 
need to identify the time slots within an exam session. 

Timetabling > Exam Scheduler > Examination Timetable Management 

 Select the required examination schedule from the drop down list 
 

 
 

 If required, click on the Set Exam Schedule as default  
 

 
 

 Click OK  

 Click Edit  
 

 Right-click on the time display for one of your exam sessions 
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 Enter the required number of time slots 

 Enter the Start and Finish times (hh:mm) for each Time Slot 
 

 
 
If the same time slots are required for the same session on other days of the exam period: 

 Check Copy slots and times to other days? 
 

 Click Save 

 

 
  

Time slots 
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5.3.11 Show/Allocate Supervisor 

 Right click in a cell where a room has been allocated and the session time slots have been 
defined 

 

 
 

 Select Show / Allocate Supervisor 
 

 
 

 Click Edit  for a timeslot 
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External supervisors are listed first, then any current staff, who are free during that time slot. You 
can also see, for each potential supervisor, how much teaching time has been lost as a result of 
the exams and how much time has already been allocated to exam supervision. 
 
To select a supervisor either: 

 Check Selected to the left of the supervisor’s name 
OR 

 Check Primary to the right of the supervisor’s name if that person is the main exam supervisor 

 

 
 

 Check OK 
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Note: Primary supervisors are marked with an asterisk. 

 Repeat for the other time slots 

 If more than one subject is being examined in the same room at the same time, and the 
allocated supervisors will be supervising all subjects, check Copy Supervisor Allocation to all 
subject in this room in this session 

 Click OK 

Note: you can only see the primary supervisors in the exam timetable grid 

 

Supervisors 
allocated to 
different exams in 
the same room. 
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Note: If supervisors have been allocated to all timeslots for a room, the right-click option 
for Show / Allocate Supervisor is re-titled to Change Supervisor. 
 

 

When supervisors have been allocated to all sessions: 

 Click  to save 
 

 
 

 Click OK 
 

5.3.12 Print Exam Timetable by Day and Time Report 

 Select the required examination schedule from the drop down list 
 

 
 

 If required, click on the Set Exam Schedule as default  
 

 
 

 Click OK  

 In View mode, click on Exam Timetable by Day and Time  
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If the grid has at least one subject on it, the Exam Timetable by Day and Time report prints as a 
Word document for the currently selected schedule. 
 

 
 

 Enter Subject Notes if required 

 Save and close 
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6 Examination Schedule Reports 

Timetabling > Exam Scheduler > Examination Schedule Reports 

 
 
 

6.1 Exam Setup Reports 

Timetabling > Exam Scheduler > Examination Schedule Reports > Exam Setup Reports 
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6.1.1 Exam Requirements Report 

Timetabling > Exam Scheduler > Examination Schedule Reports > Exam Setup Reports > Exam 
Requirements 

This report identifies the examinable subjects and any additional information relating to the subject 
exam. 
 

 If required, edit the Main Title and enter a Page Footer 

 Select the required TT Year, Campus, TT Period and Grid 
 

 
 

 To load the Subjects, click Find 

 Enter your search parameters and click Find 
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 Click Select and Yes  
 

 
 

 Remove any unwanted subjects by highlighting them in the Subjects list and clicking Remove 

 Click Print 

 

 
 

 Select your preferred Report Destination and click OK 
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Sample Exam Requirements Report 
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6.1.2 Exam Setup Definition Report 

(Timetabling > Exam Scheduler > Examination Schedule Reports > Exam Setup Reports > Exam 
Setup Definition) 

 

 If required, edit the Main Title and enter a Page Footer 

 Select the required Timetabling Year and Exam Timetable 

 Check Include Examinable Teaching Sets if required 
 

 
 

 Click Print 

 

 
 

 Select your preferred Report Destination and click OK 
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Sample Exam Setup Definition Report 

 
 

Associated Grid/s 
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6.2 Exam Timetable Reports 

Timetabling > Exam Scheduler > Examination Schedule Reports > Exam Timetable Reports 
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6.2.1 Exam Timetable by Day and Time Report 

Timetabling > Exam Scheduler > Examination Schedule Reports > Exam Timetable Reports > Exam 
Timetable by Day & Time 

The Exam Timetable by Day and Time report provides a summary of the exam timetable against 
and includes exam group sizes, subject names and codes, start and finish times, rooms, 
supervisors and supervision times. 
 

 If required, edit the Main Title and enter a Page Footer 

 Select the required Timetabling Year and Exam Timetable 

 Enter General Notes if required 
 

 
 

 Click Print 

 

 
 
The report will open in MS Word. 
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Sample Exam Timetable by Day and Time Report 

 
 

6.2.2 Exam Timetable Summary Report 

Timetabling > Exam Scheduler > Examination Schedule Reports > Exam Timetable Reports > Exam 
Timetable Summary 

The Exam Timetable Summary Report is an abbreviated version of the Exam Timetable by Day 
and Time report. 
 

 If required, edit the Main Title and enter a Page Footer 

 Select the required Timetabling Year and Exam Timetable 

 Enter General Notes if required 
 

 
 

 Click Print 
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The report will open in MS Word. 
 

Sample Exam Timetable Summary 
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6.2.3 Exam Timetable by Subject Report 

Timetabling > Exam Scheduler > Examination Schedule Reports > Exam Timetable Reports > Exam 
Timetable by Subject 

The Exam Timetable Report by Subject report provides a listing of subjects being examined and 
associated information. 
 

 If required, edit the Main Title and enter a Page Footer 

 Select the required Timetabling Year and Exam Timetable 

 Enter General Notes if required 
 

 
 

 Select the Sort tab 
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 If you do not wish to sort by subject name, drag Subject Name to the pane on the left and 
double click on your preferred sort 

 Click Print 

 

 
 

 Select your preferred Report Destination and click OK 
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Sample Exam Timetable by Subject 
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6.2.4 Exam Timetable by Room Report 

Timetabling > Exam Scheduler > Examination Schedule Reports > Exam Timetable Reports > Exam 
Timetable by Room 

 If required, edit the Main Title and enter a Page Footer 

 Select the required Timetabling Year and Exam Timetable 

 Check Print Each Room as a Separate Page 

 Enter General Notes if required 
 

 
 

 Click Print 

 

 
 
The report will open in MS Word. 
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Sample Exam Timetable by Room 
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6.2.5 Student Exam Schedule Balance Report 

Timetabling > Exam Scheduler > Examination Schedule Reports > Exam Timetable Reports > Student 
Exam Schedule Balance 

The Student Exam Schedule Balance report provides information on the number of exams each 
student has on any given day. 

 If required, edit the Main Title and enter a Page Footer 

 Select the required TT Year and Exam Schedule 

 Check Include all Students if you want all selected students included in the report 
OR 

 Edit Students with less than # Exams 

 Check Include number of Exams and Include Subject Codes as required 

 Click Find and select the students you wish to include in the report 
 

 
 

 Select the Sort tab 
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 If you do not wish to sort by Surname, drag Surname to the pane on the left and double click 
on your preferred sort 

 Click Print 

 

 
 

 The report will open in MS Word. 
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Sample Student Exam Schedule Balance 
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6.2.6 Student Exam Timetable Report 

Timetabling > Exam Scheduler > Examination Schedule Reports > Exam Timetable Reports > Student 
Exam Timetable 

The Student Exam Timetable report provides a single page per student report summarizing the 
exam information for that particular student. 
 

 If required, edit the Main Title and enter a Page Footer 

 Select the required TT Year and Exam Schedule 

 Enter a note and check Include Student Photo if you wish 

 Click Find and select the students you wish to include in the report 
 

 
 

 Select the Sort tab 
 

 

Include Number of Exams and 
Subject Codes 
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 If you do not wish to sort by Surname, drag Surname to the pane on the left and double click 
on your preferred sort 

 Click Print 

 

 
 

 Select your preferred Report Destination and click OK 
 

Sample Student Exam Timetable 
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6.2.7 Individual Supervisor Roster Report 

Timetabling > Exam Scheduler > Examination Schedule Reports > Exam Timetable Reports > 
Individual Supervisor Roster 

The Individual Supervisor Roster report provides a single page per supervisor report summarising 
the exam supervisions for that person. 
 

 If required, edit the Main Title and enter a Page Footer 

 Select the required TT Year and Exam Schedule 

 Enter a note if you wish 

 Click Find and select the teachers you wish to include in the report 
 

 
 

 Click Print 
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 Select your preferred Report Destination and click OK 
 

Sample Individual Supervisor Roster Report 

 
 

6.2.8 Supervisor Time Summary Report 

Timetabling > Exam Scheduler > Examination Schedule Reports > Exam Timetable Reports > 
Supervisor Time Summary 

The Supervisor Time Summary Report summarises the information in the Supervisor Allocation 
window in a printable format.   
 

 If required, edit the Main Title and enter a Page Footer 

 Select the required TT Year and Exam Schedule 

 Enter a note if you wish 

 Click Find and select the teachers you wish to include in the report 
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The report will open in MS Word. 

Sample Supervisor Time Summary 
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6.2.9 Individual Room Change Report 

Timetabling > Exam Scheduler > Examination Schedule Reports > Exam Timetable Reports > 
Individual Room Change 

The Individual Room Change report provides a room per page report outlining the days, periods, 
classes affected and the room to which they have been moved. 
 

 If required, edit the Main Title and enter a Page Footer 

 Select the required TT Year and Exam Schedule 

 Click Find and select the rooms you wish to include in the report 
 

   
 

 Click Print 
 

 
 

 Select your preferred Report Destination and click OK 
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Sample Individual Room Change Report 
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6.2.10 Student Listing for Exam by Subject Report 

Timetabling > Exam Scheduler > Examination Schedule Reports > Exam Timetable Reports > Student 
Listing for Exam by Subject 

The Student Listing for Exam by Subject report provides a room per page report listing the 
students taking an exam in a particular room. 
 

 If required, edit the Main Title and enter a Page Footer 

 Select the required TT Year and Exam Schedule 

 Click Find and select the subjects you wish to include in the report 
 

    
 

 Click Print 
 

 
 

 Select your preferred Report Destination and click OK 
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Sample Student Listing for Exam by Subject 
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8 Support  
 
Should you require support please contact the Customer Service Centre (CSC) at the Department 
of Education. 
 
Contact details below: 
 

Phone (CSC) 

Metro:   9264 5555 
Country:  1800 012 828 
 
Please be prepared to supply your ID number, contact details and a brief description of the 
problem. 
 

Fax (CSC) 

9264 4701 
 
Please include your ID number, contact details and a brief description of the problem. 
 

Email (CSC) 

customer.service.centre@education.wa.edu.au 
 
Please include your ID number, contact details and a brief description of the problem. 
 
 
 
 

mailto:customer.service.centre@education.wa.edu.au

